## INTRODUCTION

- Overview of the pH meter and its features.

## UNPACKING THE METER

- Instructions for unpacking the meter.

## GETTING STARTED

- Connectors for the meter.
- pH electrodes setup.

## USING THE METER

- Software installation and setup.
- Setting up the meter.
- Using the stylus.
- Setting date and time.
- Active sync setup.
- Connecting to a computer and synchronization.

## pH SETUP

- Sample ID setup:
  - Manual
  - Sequential
  - Deactivating Sample ID (None)
- Buffer group setup.
- Buffer recognition setup.
- Auto read mode.
- PH stability criteria.
- Default temperature.
- Isopotential point.
- Alarm limits.
- Print criteria setup.
- Data storage criteria setup.
- Display criteria setup.
- View stored data.
- Button functionalities.

## mV SETUP

- Sample ID setup:
  - Manual
  - Sequential
  - Deactivating Sample ID (None)
- Alarm limits.
- Print criteria setup.
- Data storage criteria setup.
- Display criteria setup.
- View stored data.
- Button functionalities.

## pH OPERATION

- Standardizing:
  - Auto buffer recognition.
- PH measurements.
- Auto read.

## mV OPERATION

- mV measurement.
- Absolute mV measurements.
- Relative mV measurements.

## CLEANING

- Instructions for cleaning the meter.

## TROUBLE SHOOTING

- Troubleshooting guide.

## WARRANTY STATEMENT

- Warranty details.

## NOTICE OF COMPLIANCE

- Compliance notices.

## WARNING

- Safety instructions.

## APPENDIX

- Determining isopotential points experimentally.
- Factory default settings.
- pH theory.
- Replacement parts.
Thank you for selecting a Fisher Scientific accumet pH meter. This manual describes the operation of the accumet XL15 meter. The state-of-the-art meter that you have purchased is easy to operate and will guide you through the various functions by displaying easy to understand prompts. This operating manual should answer any questions that might arise in operating your meter; however, do not hesitate to call our Fisher Lab Equipment Technical Support Hotline at 1-800/943-2006 or 412/490-6260, if you need any assistance.

This meter is designed to provide all the information necessary to guide you through the process of measuring pH or mV with a series of prompts on the screen. The accumet excel XL15 provides microprocessor precision in a compact benchtop design that is easy to use. One touch screen controls all procedures, letting you:

- Measure pH, absolute mV, relative mV or pH (FET)
- Select one of three sets of standard buffer groups
- Implement automatic buffer recognition
- Standardise with up to five standard or customer buffers
- Customise your display screen and operating parameters
- Assign operator and sample identification numbers
- Store 1000 data points per user in the meter’s memory or transfer data to a computer or printer.
- Access extensive online help with just a touch a button

It all adds up to rapid, completely automatic, intuitive operation.

Useful tips will appear in this box throughout this manual.
The following is a listing of what you should have received with your new accumet XL15 pH/mV meter.

**Meter with kit includes**
- meter
- power supply
- electrode arm support bracket
- electrode arm
- electrode (13-620-285)
- ATC probe (13-620-19)
- manual and literature

**Meter only includes**
- meter
- power supply
- electrode arm support bracket
- manual and literature

If any of these items are missing, please contact the Fisher Products Group Electrochemistry Operation by dialing 412/490-6267. Accessory Conductivity Probes and Ion Selective Electrodes are available and can be ordered by calling Fisher Customer Service at 800/766-7000.
Display

- Screen size: 4 1/2" x 6"
- Measurement display height: 3/4"
- Temp/etc. display height: 1/4"
- Menu options: extensive
- Help screens: extensive
- Configurable display: yes
- Keypad controls: context specific touchscreen

Memory

- Internal diagnostics: yes
- Programmable data storage: yes
- Programmable data output: store on stable, time, manual
- Print interval: 1 to 9,999 sec
- Programmable alarm: yes

pH Mode

- Range: -2.000 to 20.000
- Resolution: 0.1/0.01/0.001
- Relative accuracy: ± 0.002
- Automatic buffer recognition: yes
- Manual buffer recognition: yes
- Calibration points: 5
- Auto lock: yes
- FET: yes

mV Mode

- Range: ± 1800.0
- Resolution: 0.1
- Accuracy: ± 0.1

Temperature Mode

- Range: -5.0 to +105.0 °C
- Resolution: 0.1 °C
- Accuracy: ± 0.2 °C

General

- Inputs/Outputs: BNC, Pin, ATC, RS232, DIN (for FET)
- Electrical requirements: 115 V/60 Hz, 230 V/50 Hz
- Output from PSU: 12VDC, 500mA
- Line voltage tolerance: ± 10%
- Input impedance: >10 12 ohms
- Meter size: 5.5" x 7.5" x 3.25"
- Meter weight: 1.86 lb.

Operating Conditions

- Operating temperature: 5-45 °C
- Operation humidity: 5-80 % noncondensing
- Maximum operating altitude: 2000 m
- Installation category: II
- Pollution category degree: 2
Getting Started

1. Review the layout and arrangement of the rear connector panel.

2. Connect the electrode arm to the base.

3. Connect the power cable to the rear connector panel power jack and to a power source.
This meter allows you to use two types of pH electrodes: the conventional glass pH electrode and the AccuFET field effect transistor (FET) pH electrode. **If both types of pH electrodes are connected, the meter will read the AccuFET electrode.**

1. Carefully remove the protective cover from the end of the electrode. Before first using your glass pH electrode, or whenever the electrode is dry, soak it 2-4 hours in an electrode storage solution, pH 4 Buffer, or KCl solution.

2. Remove the shorting cap on BNC connector. Connect the **combination pH electrode** by plugging it into the BNC input connector (twisting to lock in place).

   If a combination electrode isn’t used, connect the **indicating pH electrode** into the BNC input connector. Plug the **reference electrode** into the reference pin jack. Also, install the **ATC probe** into the ATC jack.

   **Note:** Be sure to connect all probes to the appropriate **channel connectors** (for example: Input 1, Ref 1 and ATC1).

   **Option:** Connect the optional **AccuFET electrode** by plugging it into the FET jack on the back meter panel. Allow the AccuFET to warm up five minutes before use.

   **If both a conventional electrode and an AccuFET electrode are connected to the meter, do not put them in a solution together because you will get inaccurate measurements.**

Do not discard the BNC shorting cap.
3 Rinse and blot-dry (don’t wipe) electrodes between each measurement. Rinse electrodes with distilled or deionized water, or a portion of the next solution to be measured.

4 Rinse and blot-dry (don’t wipe) electrodes between each measurement. Rinse electrodes with distilled or deionized water, or a portion of the next solution to be measured.

Proper electrode care is fundamental to obtaining reliable pH measurements. Improper care of the electrode may cause the meter reading to drift, respond slowly, or produce erroneous readings. For this reason, the electrode should always be conditioned and used in accordance with manufacturer’s instructions.
confirm and is there any information we want to say or should we refer user to software instructions?

ActiveSync
Connection
Internet Explorer
Command Prompt
Windows Media Player
Do we have a standby screen or does meter start up in the Windows CE screen. Not sure so I left blank to fill in later.

Basic Screen...??Standby screen?
The new accumet XL15 benchtop pH meter operates with a state-of-the-art touch screen. The touch screen makes this the easiest meter on the market to operate and care for. When the meter is first plugged in, the STANDBY screen will appear. Touch anywhere on this screen to access the functions of the meter.

The buttons on the right side of the screen control all of the functions of the meter. A light touch on the screen is all that you need to access the various functions. Once you touch a button you will get an audible tone; the screen will not change until you lift your finger.

This design prevents rapid uncontrolled scrolling through the various function screens. Function buttons and options change from screen to screen. Easy to understand prompts guide you through the operation of the meter in the selected mode. If you are ever in doubt about what to do, just touch Help on the bottom right corner of the screen for detailed information about that screen.

The touch screen is made of a durable polyester material that is chemically resistant. Maintenance is simple with this meter. To clean the screen you just need to wipe it with a damp cloth and dry it with a clean dry towel. For additional information, see Cleaning and Troubleshooting sections of the manual.
Your XL15 Meter comes with a stylus that you should use to tap or write on your screen. The stylus easily stores inside the back panel of the meter.

You can perform three basic actions using the stylus:

**Tap**
Lightly touch the screen to select or open an item. Lift the stylus after you tap an item. Tapping is equivalent to clicking an item with the mouse on your personal computer. **Note:** Some program items require a double tap to select or launch.

**Drag**
Place the point of the stylus on the screen and drag an item across the screen without lifting the stylus until you have completed the selection. Dragging is equivalent to dragging with the left mouse button pressed on your personal computer.

**Tap and hold**
Hold the stylus pointer on an item for a short time until a menu displays. A tap and hold is equivalent to right-clicking your personal computer mouse button. When you tap and hold, a white arrow appears and where applicable a menu will soon pop up.

**CAUTION:** To prevent damage to your XL15 screen, never use any device other than the stylus that comes with the meter or an approved replacement to tap or write on the screen. Order extra or replacements if you lose or break your stylus.
When you turn on your XL15 meter for the first time, you are requested to select your time zone. After setting the time zone, you still need to set the time and date on your unit. All three settings are located in the Clock Settings screen and can be set at the same time.

Setting the Time

1. From the HOME screen tap Start > Settings > System > Control Panel. This launches the Control Panel screen.
2. Double tap Date/Time icon. This launches the Date/Time Properties window.
3. Tap the time-zone down arrow, and select the appropriate time zone.
4. Tap the hour, minutes, or seconds. Use up and down arrows to adjust.
5. Tap AM or PM. Use up and down arrows to select.
6. Tap Apply button.
7. Tap OK to save the time.

Setting the Date

1. From the HOME screen tap Start > Settings > System > Control Panel. This launches the Control Panel screen.
2. Double tap Date/Time icon. This launches the Date/Time Properties window.
3. Tap the left or right arrow to select a month and year.
4. Tap a day.
5. Tap Apply button.
6. Tap OK to save the time.

You need to reset your time zone, time, and date if:

• The time changes or you are traveling to a different time zone.
• All power to the XL15 meter is lost, which removes all saved settings.
• You perform a full reset of your XL15 meter.

By default, the time on the meter is synchronized with your personal computer each time the two devices connect using ActiveSync.
You can use Microsoft ActiveSync to:
- Synchronize information between your XL15 meter and your personal computer or server so that you have the latest information in all locations.
- Change synchronization settings and the synchronization schedule.
- Copy files between your device and personal computer.
- Install applications on your XL15 meter.
- Back up and restore device information.

**WARNING:** For synchronization to work properly, install Microsoft ActiveSync on your personal computer before you connect your XL15 to your computer.

**Connecting to a Computer**
Connect your XL15 meter to your personal computer using Microsoft ActiveSync and the USB Synchronization Cable or the wireless serial infrared (IR) connection.

**Synchronizing with Your Computer**
During ActiveSync installation, you can:
- Create partnerships that enable you to synchronize information with multiple computers.
- Select information to be synchronized with your XL15 meter (for example Files).
- When you synchronize files, you can drag and drop the selected files from your personal computer to the synchronized folder on your XL15 meter. If you named your device “PC1” when you created your partnership, then the synchronized folder is named “PC1.” When you synchronize, the files move to your XL15 meter.

To install Microsoft ActiveSync on your personal computer:
1. Insert the Companion CD into the CD tray or slot on your personal computer.
2. Select the link to install Microsoft ActiveSync.
3. Follow the instructions in the installation wizard. For more help, click the ActiveSync Help button during installation. The information you select automatically synchronizes when your installation is complete.
4. After installing ActiveSync on your personal computer, connect the XL15 meter to the personal computer using the USB Synchronization Cable.
Using the Serial Infrared (IR) Connection
As an alternative to using the USB Synchronization Cable, you can synchronize your XL15 meter and your personal computer using an infrared connection if you have an infrared port or an infrared USB adapter installed on your computer.

NOTE: The infrared connection option works only on computers that have Microsoft Windows 98SE, Me, 2000, or XP operating systems installed.

To set up an infrared connection to a computer:
1. Synchronize your XL15 meter with your computer using the USB Synchronization Cable.
2. Follow your computer manufacturer's instructions to install and set up an infrared port.
3. Remove the cable from the XL15 meter and line up the infrared port with the computer infrared port so they are unobstructed and within 12 inches (30.5 cm) of each other.
4. Initiate a connection by tapping Start > Programs > ActiveSync > Tools > Connect via IR. Synchronization begins on your device.
5. To disconnect, move the devices away from each other or tap X in the upper right of the screen to turn off.

Changing Synchronization Settings
• You can modify your synchronization settings for Microsoft ActiveSync to:
  • Change when your XL15 meter synchronizes with your personal computer or server.
  • Change the type of connection from your XL15 meter to your computer (for example, serial, USB, infrared connections).
  • Select the files and information to synchronize with your computer.
  • Select the files and information you do not want to synchronize with your computer (for example, e-mail attachments).
  • Determine how conflicts between information on your XL15 meter and information on your computer are handled.

To change synchronization settings:
1. From the Start menu on your personal computer, click Programs > Microsoft ActiveSync > Tools > Options.
   a. On the Sync Options tab, select the files and information to synchronize with your personal computer.
   b. On the Schedule tab, select when your XL15 meter synchronizes with your personal computer.
   c. On the Rules tab, determine how conflicts between information on your XL15 meter and information on your personal computer are handled.
2. Tap OK when you are finished.
3. From the File menu, click Connection Settings. Select the type of connection to be allowed between the XL15 meter and the personal computer.
**Copying Files**
You can copy files to and from your personal computer using Explore in ActiveSync and Windows Explorer.

To copy files:
1. From the **Start** menu on your personal computer, click **Programs > Microsoft ActiveSync**.
2. Click **Explore**.
3. Double-click the **My Pocket PC** icon.
4. On your personal computer, right-click the Start menu, and select **Explore**.
5. Locate the file to be moved.
6. Drag and drop your files between your XL15 meter and your computer. ActiveSync converts the files so that they can be used by the Pocket Office applications, if necessary.

**Installing Programs**
To install programs on your XL15 meter from your personal computer using ActiveSync:

1. Connect your XL15 meter to your personal computer using the USB Synchronization Cable.
2. Follow the instructions provided with the program and by the installation wizard.
3. Check the screen of your XL15 meter to see if any further steps are necessary to complete the program installation.

**Backing up and Restoring**
To help reduce the chance of losing information, you should back up information to your computer regularly. For more information on backing up and restoring information using Microsoft ActiveSync.
Using the On-Screen Keyboard
Use the stylus to tap letters, numbers, and symbols on the on-screen keyboard to enter typed text directly onto the screen.

1. From any application, tap the up arrow next to the Input Panel icon.
2. Tap Keyboard to display a keyboard on the screen.
3. Tap a letter, symbol, or number to enter information.
4. Tap OK.

The Transcriber option is not available on all models.

To see symbols, tap the 123 or Shift key.

Confirm. Could not get this to work.

We only have one model...is it available on this one?
Expansion Cards
You can expand the memory and connectivity of your XL15 meter.

Use optional expansion cards for:
- Connecting wirelessly or connecting by using a cable to the Internet or to a network
- Adding functionality such as a digital camera
- Expanding the memory of your XL15 meter
- Viewing the content of memory cards

Expansion cards must be purchased separately and are not included with your XL15 meter

Installing an Expansion Card
To install a Secure Digital (SD) card into an expansion slot on the XL15 meter:

1. Locate the slot on the top of XL15 meter.
2. Remove the protective plastic card.
3. Insert the expansion card into the expansion slot and push the connection edge of the card firmly into the expansion slot.
4. To prevent power loss, remove any expansion cards from the SDIO expansion slot before turning off the XL15 meter. Leaving in the expansion card can drain the unit.

If your expansion card is not recognized, follow the card manufacturer’s instructions to install it.

Removing a Secure Digital (SD) Expansion Card
1. Close all applications that are using the expansion card.
2. Remove a card from the Secure Digital expansion slot by slightly pushing down on the card to unlock it.
3. When the card disengages and pops up, pull it from the expansion slot.

CAUTION: SD cards must first be unlocked before removal.

Viewing the Content of Memory Cards
Use File Explorer to view the files that are located on your optional Secure Digital card.

1. From the Start menu, tap Programs > File Explorer.
2. Tap the root directory of My Device, and select the Storage Card folder (SDIO) to see a list of files and folders.
Connecting to Internet

Use your XL15 meter to connect to the Internet or your Work network.

To send and receive e-mail with Inbox and to view Web sites with Pocket Internet Explorer, you must set up a remote connection with devices such as a Secure Digital Input/Output (SDIO) modem card, ethernet card, or a wireless 802.11x card. Another option is to use a Bluetooth-enabled device such as a phone or LAN Access point.

Use of dial-up and wireless Internet, e-mail, corporate networks, and other wireless communications, such as Bluetooth-enabled devices, may require separately purchased additional hardware and other compatible equipment, in addition to a standard Wireless LAN (WLAN) infrastructure and a separately purchased service contract. Check with your service provider for availability and coverage in your area. Not all Web content may be available.

Some Web content may require installation of additional software.

Connecting to a Private Network

1. Before you start, be sure to have your server phone number, user name, and password. This information can be obtained from your network administrator.
2. Tap Start > Settings > Connections tab > Connections icon.
3. In My Work Network, set up a new modem connection, new VPN Server connection, or proxy server connection.
4. Start the connection by inserting the necessary modem card into the XL15 meter, and start using Pocket Internet Explorer. Your device automatically begins connecting.

Entering an Internet Address

With Pocket Internet Explorer and a connection to the Internet, you can view Web sites on your XL15 meter by typing an address or Universal Resource Locator (URL) in the Address bar. Web sites that use HTML 4.0, DHTML, animated GIF images, and Java applets may not work correctly in Pocket Internet Explorer without additional software.

To enter an Internet address (URL) on your XL15 meter:

1. From the Start menu, tap Internet Explorer > Address Bar. If the Address Bar is not visible, tap the View tab > Address Bar to turn it on.
2. Enter the Internet address (URL) in the Address bar.
3. Tap the Go icon.

Using a Favorites List

With Pocket Internet Explorer and a connection to the Internet, you can view Web sites on your XL15 meter by selecting one from your Favorites list.

To select a Web site from your Favorites list:

1. From the Start menu, tap Internet Explorer.
2. Tap the Favorites icon and the Web site you want to view.
The XL15 is a multi-channel meter. With this meter you can switch from channel 1 to channel 3. You cannot view both channels at the same time by accessing the dual channel mode. The setup parameters for each screen independently of one another.

Choosing a channel

1. Touch Ch1 or Ch3 on the main screen to select a channel.

If you are in any measurement mode, touch Mode until you access the main screen.
The touch screen of your XL15 bench meter has “buttons” along the right side of the screen that are common to many of the screens. The following indicates the function of these common buttons.

- **Standardize** button accesses the standardization screen from the various measure modes and initiates standardization of the meter once the standardization screen is accessed.

- **Measure** button directs the meter to measure your sample when in the Auto Read function of the pH or pH (FET) modes.

- **Mode** button allows you to switch between the various operations of the meter—pH, mV and pH (FET)

- **Setup** button will access the setup screens of the measuring mode that you are currently using.

- **Print** button will send information to the output device that you are connected to your meter. The output device can be a printer or data logger. Touching the Print button will also send data to the data storage center of the meter if a sample ID# has been assigned to your sample.

- **Log Data** button sends data to the data storage center of the meter if a sample ID# has been assigned to your sample.

- **Profile** button lets you view your profile (User ID, Password, Company Name, User Group) You can change only your profile and not of any other user. You can change to a different user only if you are the default user of the system.

- **Home** button accesses the Windows CE desktop. The XL15 application does not shut down if Home is pressed and the current user remains logged in. Double tap on the XL15 icon to return to the previous screen before the Home button was pressed.

- **Logoff** button allows you to logoff the current user from the XL15 application. The XL15 application shuts down returning to the Win CE desktop. When you re-start the application, you go to the main screen of the application. The second time you are logged in as the default user of the system.

- **Help** button allows you to access helpful information on any screen. Touching the Help button gives you information about the current screen. This information will include step-by-step instructions for operating the meter from the current screen and possible applications information for that screen.

- **Sys.Setup** button allow you to turn on or off the beep status. This is the audible beep that sounds each time any button is touched. The Sys.Setup button is only accessible in the Mode screen.
The `rel mV` button returns the meter into the relative millivolt mode when in the absolute mV mode. When this mode is activated, a window will appear asking you to set a relative mV value or accept the default value of 0 mV. This feature may assist the user to standardize certain analytical and monitoring activities such as titration. **This button only appears when the meter is in the absolute mV mode.**

The `abs mV` button returns the meter to absolute millivolt mode when the meter is in the relative mV mode. This button only appears when the meter is in the relative mV mode.

The following buttons appear in the pH and pH (FET) standardization screens:

- **Confirm** button accepts current value of the buffer being standardized. **This button only appears in the pH and pH (FET) standardization screens.**
- **Clear** button clears all previous standardization points. **This button only appears in the pH and pH (FET) standardization screens.**
- **Cancel** button cancels current standardization and returns to the pH measurement screen. **This button only appears in the pH and pH (FET) standardization screens.**
- **Temp Std** button allow you to check the accuracy of your temperature probe and standardize to an accurate thermometer.

The following buttons appear in the mode screen after Ch1 or Ch3 is selected:

- **pH** mode button allows you to switch to the various pH operations of the meter.
- **pH (FET)** mode button allows you to switch to the various pH (FET) operations of the meter.
- **mV** mode button allows you to switch to the various mV operations of the meter.
The pH Setup screen present many options to control the operating parameters of the meter. The meter is factory set with regard to these options, and is ready for use under most circumstances (see appendix for default settings). The operating parameters of the pH mode can be set and controlled from the pH setup screen. The pH Setup section will guide you through the various options available in the pH setup mode.

Function buttons on pH Setup Screen

Touch OK to confirm pH Setup and return to the pH Measure screen.

Touch Cancel to exit and return to the pH Measure screen without confirming pH Setup.

Touch View to view all pH data points stored in memory. See page XX for details.

When you touch the Help button, information about the current screen appears. This information includes step-by-step instructions for operating the meter from the current screen and possible applications information for that screen.

Touch Reset to reset all pH Setup Criteria to the factory default.
There is one way to access the pH Setup screen.

1. Make sure meter is in pH Measure mode. Touch pH on the mode screen to access the pH mode Measure screen
2. Touch Setup option on the pH Measure screen
Whenever this option is active, each time you touch **Print** or **Log Data** on the pH Measure screen, the pH (or pH FET) value along with date/time/channel and the sample ID will be sent to data storage. You can manually enter an alphanumeric identification number of 10 characters for any sample or you can have the meter sequentially number your samples beginning at the number of your choice. You can also choose to deactivate the sample ID.

**To set sample ID — Manual:**
1. Touch **Manual** for manual Sample ID entry
2. The current ID is displayed on the screen
3. Use the alphanumeric keypad on the screen to enter the desired Sample ID. The **BS** key will allow you to backspace to remove a character that was incorrectly entered.
4. Touch **Enter** to accept current Sample ID and return to the pH (or pH FET) Setup screen.

**To set sample ID — Sequential**
1. Touch **Sequential** for sequential Sample ID entry
2. The current ID is displayed on the screen
3. Use the numeric keypad on the screen to enter the desired Sample ID number that you would like your sequential Sample ID assignment to begin with. Every time you touch **Print** or **Log Data** on the pH Measure screen, the Sample ID will increase by 1. The **BS** key will allow you to backspace to remove a character that was incorrectly entered.
4. Touch **Enter** to accept the first sequential Sample ID and return to the pH (pH FET) Setup screen.

**To deactivate the sample ID assignment — None**
1. Touch **None** to deactivate the sample ID assignment
This setup option allows you to select from 3 different buffer groups, for auto buffer recognition. Or you can create a custom group of buffers for auto buffer recognition by touching custom.

The 3 existing buffer groups are:

- **USA buffers:** 2, 4, 7, 10, 12
- **European buffers:** 1, 3, 6, 8, 10, 13
- **NIST buffers:** 1.68, 4, 6.86, 9.18, 12.45

To select buffer group

1. Touch **USA**, **EURO**, **NIST** or **CUSTOM** from the setup screen to select a buffer group.

To set Custom pH buffer group

This option allows you to create a custom buffer group of up to 5 buffers (2 buffer minimum) to be used for auto buffer recognition. To obtain optimal results, it is important to maintain at least 1 pH unit between selected buffers in the custom group.

1. Touch **CUSTOM** on the setup screen to select a custom buffer. This will display a set of 5 custom beakers each initialized to zero.

2. Touch one of the beakers to display the numeric keypad.

3. Enter a value for the custom pH buffer that you want set in your custom buffer set.

4. Press **Enter** in the keypad to accept the value.

5. Repeat steps 2 through 4 until all 5 custom buffer beakers are populated with desired values.

6. To modify the value entered, touch the particular beaker and key in the new value using keypad.

7. To clear all custom buffer values, touch **CLEAR**.
This option allows you to select Automatic buffer recognition or manual buffer recognition when standardizing. With the automatic buffer recognition activated, the meter will automatically recognize the buffers from the chosen buffer group and accept them when the meter recognizes the reading as stable. When in the Manual buffer recognition mode, you must enter the buffer value during the standardization procedure. The meter will accept the manually entered buffer when you recognize that the measurement is stable. During the standardization procedure, you may accept the buffer value before the meter recognizes it as stable by touching the Standardization button.

To select Buffer Recognition

1. Touch MANUAL or AUTO to choose the method of buffer selection.
You can use this meter when the Auto Read function is active or when it is inactive. When the Auto Read function is active, the meter will lock onto a reading when the meter recognizes it as stable. The meter will not deviate from this reading until Measure is touched. If the Auto Read function is inactive, then the meter will continuously monitor the pH of the sample and the Measure screen display will indicate any fluctuation in the sample pH.

**To select Auto Read Mode**

1. Touch **MANUAL** or **AUTO** to choose the desired read mode.
This setup screen allows you to determine how quickly the meter will respond to electrode drift. There are 3 speed settings: fast, medium and slow.

To set pH Stability Criteria

1. Touch FAST, MEDIUM, SLOW to choose the desired stability criteria.

Stability criteria are more stringent at the slower setting. Therefore, if the highest precision is required, then a slow setting would be desired. The default setting is the medium speed and this should be adequate for the majority of applications without making any changes.
It is a well known fact that pH is a temperature dependant measurement. The factory default setting is 25°C. If you are taking the pH of a solution that is not 25°C and you are not using an Automatic Temperature Compensation (ATC) probe, then you should enter the temperature value of that solution in order to get the correct pH value. The current default temperature setting will be displayed on the screen.

The default temperature can be set from -5°C to 105°C.

To set Default Temperature

1. Select temperature units by touching the appropriate unit button: C (Celsius), F (Fahrenheit) or K (Kelvin)
2. Touch the Default Temperature box and use the numeric keypad to enter the desired default temperature (-5°C to 105°C).
3. Press Enter in the keypad to return to pH (pH FET) Setup screen

The use of an ATC probe provides a measured temperature value to the meter and will override any value entered in the default temperature screen. This measured value will be used by the meter to make pH calculations.
The isopotential point is the millivolt reading for an electrode at which temperature has no effect on the measurement. pH electrodes are constructed so that the isopotential point is theoretically zero millivolts. This is very close to a pH of 7. Most pH electrodes do not achieve this value precisely. However they are close enough so that it is not usually necessary to use an isopotential point other than zero. The true isopotential point of any given electrode must be determined experimentally. (See Appendix: Determining Isopotential Points Experimentally, page 101)

The isopotential point can be set from -100 to +100

**To set isopotential Point**

1. Touch the **Isopotential Point** box and use the numeric keypad to enter the desired mV setting for the new isopotential point.
2. Touch **Enter** to accept this value and return to pH (pH FET) Setup screen.
This option allows you to set alarm limits for the pH measuring mode. If the pH value of the measurement is outside of the boundaries set by the minimum and maximum limits, a visual warning will appear to let you know that your sample measurement was outside of the set limits.

The Alarm Limit can be set from -2 pH to 20 pH.

To set Alarm Limits:
1. Touch ON or OFF to set the status of the alarm of pH (pH FET) mode.
2. Touch the Low box and use keypad to enter the new limit values.
3. Touch Enter on the keypad to accept this limit and return to the pH (pH FET) Setup screen.
4. Touch the High box and use keypad to enter the new limit values.
5. Touch Enter on the keypad to accept this limit and return to the pH (pH FET) Setup screen.
This screen allows you to select which criteria are printed with the measurement when you print the data or send it to a computer. The status of the current print criteria is displayed on the screen. The criteria option is active if **ON** appears to the right of the option. It is inactive if **OFF** appears to the right of the option. Any active criteria will be printed on demand.

**To set Print Criteria**

1. Touch the **Touch here to edit** button next to the **Print Criteria** to access the pH Print Criteria Setup screen.
2. Touch **ON** or **OFF** to change the status of a criteria you want to modify.
3. Repeat step 2 for all the remaining criteria except **Print Interval**.
4. For **Print Interval**, touch **MANUAL** to print pH data only when the **Print** button is pushed, touch **STABLE** to automatically print pH data when pH reading is stable, or touch **TIMED** to set a specific timed interval in seconds to print pH data.
5. Touch **OK** button to accept the changes of the entire group of print criteria and return to the pH (pH FET) Setup screen.
This screen allows you to select which criteria are stored in the data logger with the measurement when you store the data. The status of the current data storage criteria is displayed on the screen. The criteria option is active if ON appears to the right of the option. It is inactive if OFF appears to the right of the option. Any active criteria will be stored on demand.

To set Data Storage Criteria
1. Touch the Touch here to edit button next to the Data Storage Criteria to access the pH Data Storage Setup screen.
2. Touch ON or OFF to change the status of a criteria you want to modify.
3. Repeat step 1 for all the remaining criteria.
4. Touch OK button to accept the changes of the entire group of data storage criteria and return to the pH (pH FET) Setup screen.
This screen allows you to choose what information you would like to be displayed on the pH Measure screen, particularly the information contained in the data box at the bottom of the Measurement screen. The status of the current display criteria is displayed on the screen. The criteria option is active if ON appears to the right of the option. It is inactive if OFF appears to the right of the option.

To set Display Criteria

1. Touch the Touch here to edit button next to the Display Criteria to access the pH Display Criteria Setup screen.
2. Touch ON or OFF to change the status of a criteria you want to modify.
3. Repeat step 2 for all the remaining criteria except Display Resolution.
4. For Display Resolution, touch X.X to display pH with one decimal place, touch X.XX to display pH with two decimal places, or touch X.XXX to display pH with three decimal places.
3. Touch OK button to accept the changes of the entire group of display criteria and return to the pH (pH FET) Setup screen.
The XL15 has a memory capacity to store up to 1000 data points. The View Stored Data screen allows you to sort and look at specific data points stored in the meter based on the meter’s memory capacity. The stored data can be sorted by any of the parameters available in the screen header.

The meter stores pH or pH (FET) data under the following parameters:
- Reading
- Operator
- Date / Time / Channel
- Sample Id
- Temperature
- Last Standardizations
- Current Buffers
- Slope
- mV Measurement
- Meter Model Serial No.

To View Stored Data:
1. Touch the View button in the pH Setup screen

You can only log 1000 data points at a time. To clear space for new data points, you have to delete the same number of old data points as you want to add new data points.
Function buttons on View Stored Data Screen

Touch **OK** to go back to the pH Setup screen from the View Stored Data screen.

When you touch the **Help** button, information about the current screen appears. This information includes step-by-step instructions for operating the meter from the current screen and possible applications information for that screen.

Touch **Delete** to delete a selected data point from the list. To delete a data point, first touch the data point you want to delete then touch the **Delete** button.

Touch **Delete All** to delete all the data points in the memory.

Touch **Print** to print all the data points in the memory.

<table>
<thead>
<tr>
<th>Reading</th>
<th>Operator</th>
<th>Date / Time / Channel</th>
<th>Sample Id</th>
<th>Temperature</th>
<th>Last Stan</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.00</td>
<td>Default</td>
<td>12/2/2023</td>
<td>15</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>8.53</td>
<td>Default</td>
<td>12/2/2023</td>
<td>14</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>8.85</td>
<td>Default</td>
<td>12/2/2023</td>
<td>13</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.05</td>
<td>Default</td>
<td>12/2/2023</td>
<td>12</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.34</td>
<td>Default</td>
<td>12/2/2023</td>
<td>11</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.50</td>
<td>Default</td>
<td>12/2/2023</td>
<td>10</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.50</td>
<td>Default</td>
<td>12/2/2023</td>
<td>9</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.50</td>
<td>Default</td>
<td>12/2/2023</td>
<td>8</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.50</td>
<td>Default</td>
<td>12/2/2023</td>
<td>7</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>9.50</td>
<td>Default</td>
<td>12/2/2023</td>
<td>6</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>10.02</td>
<td>Default</td>
<td>12/2/2023</td>
<td>5</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>12.45</td>
<td>Default</td>
<td>12/2/2023</td>
<td>4</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>12.55</td>
<td>Default</td>
<td>12/2/2023</td>
<td>3</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>12.55</td>
<td>Default</td>
<td>12/2/2023</td>
<td>2</td>
<td>25.0</td>
<td>---</td>
</tr>
<tr>
<td>12.85</td>
<td>Default</td>
<td>12/2/2023</td>
<td>1</td>
<td>25.0</td>
<td>---</td>
</tr>
</tbody>
</table>
The mV Setup screen present many options to control the operating parameters of the meter. The meter is factory set with regard to these options, and is ready for use under most circumstances (see appendix for default settings). The operating parameters of the mV mode can be set and controlled from the mV setup screen. The mV Setup section will guide you through the various options available in the mV setup mode.

**Function buttons on mV Setup Screen**

- Touch **OK** to confirm mV Setup and return to the mV Measure screen.
- Touch **Cancel** to exit and return to the mV Measure screen without confirming mV Setup.
- Touch **View** to view all mV data points stored in memory. See page XX for details.
- When you touch the **Help** button, information about the current screen appears. This information includes step-by-step instructions for operating the meter from the current screen and possible applications information for that screen.
- Touch **Reset** to reset all mV Setup Criteria to the factory default.
There is one way to access the mV Setup screen.

1. Make sure meter is in mV Measure mode. Touch mV on the main screen to access the mV mode Measure screen
2. Touch Setup option on the mV Measure screen
Whenever this option is active, each time you touch **Print** or **Log Data** on the mV Measure screen, the mV value along with date/time/channel and the sample ID will be sent to data storage. You can manually enter an alphanumeric identification number of 10 characters for any sample or you can have the meter sequentially number your samples beginning at the number of your choice. You can also choose to deactivate the sample ID.

**To set sample ID — Manual:**
1. Touch **Manual** for manual Sample ID entry.
2. The current ID is displayed on the screen.
3. Use the alphanumeric keypad on the screen to enter the desired Sample ID. The **BS** key will allow you to backspace to remove a character that was incorrectly entered.
4. Touch **Enter** to accept current Sample ID and return to the mV Setup screen.

**To set sample ID — Sequential**
1. Touch **Sequential** for sequential Sample ID entry
2. The current ID is displayed on the screen
3. Use the numeric keypad on the screen to enter the desired Sample ID number that you would like your sequential Sample ID assignment to begin with. Every time you touch **Print** or **Log Data** on the pH Measure screen, the Sample ID will increase by 1. The **BS** key will allow you to backspace to remove a character that was incorrectly entered.
4. Touch **Enter** to accept the first sequential Sample ID and return to the mV Setup screen.

**To deactivate the sample ID assignment — None**
1. Touch **None** to deactivate the sample ID assignment
This option allows you to set alarm limits for the mV measuring mode. If the mV value of the measurement is outside of the boundaries set by the minimum and maximum limits, a visual warning will appear to let you know that your sample measurement was outside of the set limits.

The Alarm Limit can be set from -2000.00 mV to 2000.00 mV

To set Alarm Limits
1. Touch ON or OFF to set the status of the alarm of mV mode
2. Touch the Low box and use keypad to enter the new limit values.
3. Touch Enter on the keypad to accept this limit and return to the pH mV Setup screen.
4. Touch the High box and use keypad to enter the new limit values.
5. Touch Enter on the keypad to accept this limit and return to the mV Setup screen.
This screen allows you to select which criteria are printed with the measurement when you print the data or send it to a computer. The status of the current print criteria is displayed on the screen. The criteria option is active if **ON** appears to the right of the option. It is inactive if **OFF** appears to the right of the option. Any active criteria will be printed on demand.

**To set Print Criteria**

1. Touch the **Touch here to edit** button next to the Print Criteria to access the mV Print Criteria Setup screen.
2. Touch **ON** or **OFF** to change the status of a criteria you want to modify.
3. Repeat step 2 for all the remaining criteria except **Print Interval**.
4. For Print Interval, touch **MANUAL** to print mV data only when the **Print** button is pushed, touch **STABLE** to automatically print mV data when mV reading is stable, or touch **TIMED** to set a specific timed interval in seconds to print mV data.
5. Touch **OK** button to accept the changes of the entire group of print criteria and return to the mV Setup screen.
This screen allows you to select which criteria are stored in the data logger with the measurement when you store the data. The status of the current data storage criteria is displayed on the screen. The criteria option is active if **ON** appears to the right of the option. It is inactive if **OFF** appears to the right of the option. Any active criteria will be stored on demand.

**To set Data Storage Criteria**

1. Touch the **Touch here to edit** button next to the Data Storage Criteria to access the mV Data Storage Setup screen.
2. Touch **ON** or **OFF** to change the status of a criteria you want to modify.
3. Repeat step 1 for all the remaining criteria.
4. Touch **OK** button to accept the changes of the entire group of data storage criteria and return to the mV Setup screen.
This screen allows you to choose what information you would like to be displayed on the mV Measure screen, particularly the information contained in the data box at the bottom of the Measurement screen. The status of the current display criteria is displayed on the screen. The criteria option is active if **ON** appears to the right of the option. It is inactive if **OFF** appears to the right of the option.

To set Display Criteria

1. Touch the **Touch here to edit** button next to the Display Criteria to access the mV Display Criteria Setup screen.
2. Touch **ON** or **OFF** to change the status of a criteria you want to modify.
3. Repeat step 2 for all the remaining criteria except **Display Resolution**.
4. For Display Resolution, touch **X.X** to display mV with one decimal place or touch **X.XX** to display mV with two decimal places.
5. Touch **OK** button to accept the changes of the entire group of display criteria and return to the mV Setup screen.
The XL15 has a memory capacity to store up to 1000 data points. The View Stored Data screen allows you to sort and look at specific data points stored in the meter based on the meter's memory capacity. The stored data can be sorted by any of the parameters available in the screen header.

The meter stores mV data under the following parameters:
- Reading
- Operator
- Date / Time / Channel
- Sample Id
- Meter Model Serial No.

**To View Stored Data**
1. Touch the View button in the mV Setup screen

You can only log 1000 data points at a time. To clear space for new data points, you have to delete the same number of old data points as you want to add new data points.
Function buttons on View Stored Data Screen

Touch OK to go back to the mV Setup screen from the View Stored Data screen.

When you touch the Help button, information about the current screen appears. This information includes step-by-step instructions for operating the meter from the current screen and possible applications information for that screen.

Touch Delete to delete a selected data point from the list. To delete a data point, first touch the data point you want to delete then touch the Delete button.

Touch Delete All to delete all the data point in the memory.

Touch Print to print all the data points in the memory.
In this mode, you will be able to measure the pH of a wide variety of samples. Before measuring pH, you will need to standardize the meter using buffers with known pH values. It is good practice to standardize the meter frequently using a minimum of two buffers. Using two buffers allows the meter to calculate and display an actual slope for the electrode, and therefore produce more accurate measurements. If there is no standardization in the memory of the meter or if only one buffer has been used to standardize the meter, the slope value will appear as “......”.

You can standardize your meter using automatic or manual buffer recognition. With the Automatic buffer recognition activated (ON), the meter will automatically recognize the buffers from the chosen buffer group and flash the current buffer. When the reading is stable, you must confirm the buffer. In the Manual buffer recognition mode, you must enter the buffer value during the standardization procedure. The meter will flash the manually entered buffer, you must confirm the buffer when the reading is stable. During the standardization procedure, you may accept the buffer value before the meter recognizes it as stable by touching confirm. See page 58 to select desired buffer recognition.

Remember to setup your pH measuring mode parameters. Refer for pH Setup section for instructions.

Connect the electrodes you will be using to the meter.

**pH measure screen without standardization**
> Touch "Confirm" to Standardize the buffer  
> Touch "Clear" to clear the previous Standardization  
> Touch "Cancel" to return to the Measurement  
> Touch "Temp Std" for Temperature Standardization

<table>
<thead>
<tr>
<th>Sample ID</th>
<th>Temp.</th>
</tr>
</thead>
<tbody>
<tr>
<td>User ID</td>
<td>mV</td>
</tr>
<tr>
<td>Auto Buffer</td>
<td>Slope</td>
</tr>
<tr>
<td>Auto Read</td>
<td>Offset</td>
</tr>
</tbody>
</table>

Last Standardization: 7 Mar 2004 / 10:06:37 PM  
Buffer Group: USA  

> Touch "Confirm" to Standardize the buffer  
> Touch "Clear" to clear the previous Standardization  
> Touch "Cancel" to return to the Measurement  
> Touch "Temp Std" for Temperature Standardization

| pH-Standardize Channel 1 | pH-Standardize Buffer Group: USA  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>12.000</td>
<td>Stable</td>
</tr>
<tr>
<td>2.000</td>
<td>4.000</td>
</tr>
<tr>
<td>7.000</td>
<td>10.000</td>
</tr>
<tr>
<td>12.000</td>
<td>12.000</td>
</tr>
</tbody>
</table>

Last Standardization: 7 Mar 2004 / 10:06:37 PM  
Buffer Group: USA  

Sample ID : ---  
User ID : Default  
Auto Buffer : ON  
Auto Read : OFF  
Temp. : 25.5 C (ATC)  
mV : 0.0  
Slope : ......  
Offset : ......  

7:25 PM
To Standardize the meter with Auto Buffer Recognition

1. Touch Standardize on the pH measure screen to access the standardized screen.
2. If the screen says "Not standardized" proceed to step 4.
3. Touch Clear to delete all previous standardization values.
4. Immerse your rinsed electrode(s) and temperature probe in a buffer solution from the selected buffer group that you chose during the pH setup process and stir gently. The selected buffer group appears on the standardization screen.
5. The screen will flash a beaker icon of the buffer solution you have selected. When the reading is stable, STABLE appears on the screen. Touch Confirm to standardize the buffer. The meter will then return to the pH measure screen.
6. Touch Standardize on the pH measure screen to access the standardization screen and repeat steps 4 through 6 to standardize with up to 5 buffers.

The efficiency of the electrode is reported as the slope. When doing a multi-point standardization, the slopes of the individual segment are calculated by the meter. The slope that appears on the screen is the slope that is the least perfect, or the farthest from 100%.

For optimal results, the meter should be standardized at a minimum of every 8 hours. For more accurate measurements, the meter should be standardized more frequently.

Note: meter does not update a standardization. I took references out.

Once meter is calibrated pH Measure screen shows the buffers that have been standardized and the time/date of last standardization.
12.000
STABLE

Stable pH Standardization

Sample ID: ---
User ID: Default
Auto Buffer: ON
Auto Read: OFF
Temp.: 25.5°C (ATC)
mV: 0.0
Slope: ......
Offset: ......

> Touch "Confirm" to Standardize the buffer
> Touch "Clear" to clear the previous Standardization
> Touch "Cancel" to return to the Measurement
> Touch "Temp Std" for Temperature Standardization

Last Standardization: 8 Mar 2004 / 4:06:37 PM
Buffer Group: CUSTOM
To standardize the meter with Manual Buffer Recognition:

1. Touch **Standardize** on the pH measure screen to access the standardized screen.
2. If the screen says **“Not standardized”** proceed to step 4.
3. Touch **Clear** to delete all previous standardization values.
4. Immerse your rinsed electrode(s) in a buffer solution and stir gently.
5. The screen will flash a beaker icon. Touch the flashing beaker icon. Using the displayed keypad input the value of the buffer that you are using to standardize the meter and then touch **Enter**. The meter now shows the buffer value in the flashing beaker.
6. When the reading is stable, **STABLE** appears on the screen. Touch **Confirm** to standardize the buffer. The meter will then return to the pH measure screen.
7. Touch **Standardize** on the pH measure screen to access the standardization screen and repeat steps 4 through 7 to standardize with up to 5 buffers.

Once meter is calibrated pH Measure screen shows the buffers that have been standardized and the time/date of last standardization.
**To standardize temperature of the meter**

1. Touch **Standardize** on the pH measure screen to access the standardized screen.
2. Make sure ATC probe is attached to meter.
3. Immerse your ATC probe into a solution of known temperature, such as a temperature bath, for a few minutes while temperature stabilizes.
4. Touch **Temp Std** to access temperature standardization.
5. The Temperature Standardization screen appears. Check the current temperature displayed with that of the solution of known temperature. Touch the **Standardization Temperature** box and use numeric keypad to enter the current temperature. Press **Enter** to confirm value.
6. Touch **OK** to confirm Standardization Temperature and return to the pH Measure screen. Touch **Reset** to reset and enter a new standardization temperature. Touch **Cancel** to cancel temperature standardization and return to the pH Standardization screen.

**Note:** The meter will not allow entered value to exceed ±5° of the ATC probe value. If entered value exceeds ±5° an error window will appear and you will have to re-enter value or cancel out of the temperature screen. This might indicate that you have a faulty ATC probe.
pH Measure screen with Auto Read ON
The measure screen provides readout of the current sample measurement. You can use this meter when the Auto Read function is active or when it is inactive. When the auto read function is active, the meter will lock onto a reading when the meter recognizes it as stable. The meter will not deviate from this reading until the Measure button is touched. If the Auto Read mode is inactive, then the meter will continuously monitor the pH of the sample and the measure display screen will indicate any fluctuation in the sample pH. Regardless of the status of the Auto Read mode, **STABLE** will flash as the meter recognizes the measurement as stable.

Once the meter is standardized, you are ready to take pH measurements of your sample.

**To Measure pH of a Sample with Auto Read ON**
1. Immerse the rinsed electrode(s) in the sample and stir gently.
2. Touch **Measure** to begin measuring your sample. The meter will accept the reading and display **STABLE** when the measurement meets the selected stability criteria.

**OR**

**To Measure pH of a Sample with Auto Read OFF**
1. Immerse the rinsed electrode(s) in the sample and stir gently.
2. Record the reading once the measurement has become stable. **STABLE** will appear once the meter recognizes that the measurement is stable.

**NOTES:** You can access other functions of the meter with the remaining buttons on the measure screen.

- Touching **Print** will send the data to the meter's memory if the sample ID# is activated and to a printer or a computer if it is attached to the meter. The saved data can be accessed through the View Storage Data screen in the pH Setup mode.
- Touching **Setup** will access the pH Setup screen.
- Touching **Measure** will initiate a new measurement of a sample with Auto Read ON.
- At anytime, you can touch **Mode** to access another mode of operation including: mV, rel mV or the setup mode or place the meter in the standby mode.
This mode is used to measure oxidation/reduction potential (ORP/redox), perform titration and to verify the function of the meter. The mV measure function allows you to continuously monitor the mV potential of the electrodes in use. This can be done in either absolute or relative mV. In the millivolts mode, the current millivolt output from the electrodes being used is monitored and displayed on the screen. The meter will continually monitor the millivolts reading in this mode and will not lock onto a single reading. However, once the reading has become stable, a **STABLE** will be displayed. Remember to setup your mV measuring mode parameter (see mV Setup section).

> Touch rel mV icon for relative mV reading

**Sample ID**: —
**User ID**: Default
**Temp.**: 25.5 C (ATC)
**Offset**: 0.0 mV
In the mV mode, you will be able to make measurements in either absolute or relative millivolts, access the mV Setup screens and print your results to a printer or a computer.

Connect the electrodes you will be using to the meter. See page xx for details.

**Absolute mV measurements**
1. Access the mV measure screen from the main screen.
2. Touch **abs mV** to access the Absolute mV screen.
3. Immerse the rinsed electrode(s) in the sample and stir gently.
4. Record the measurement when **STABLE** is displayed.
5. Touch **Print** to store a measurement with an assigned ID# in the data storage center of the meter or print the data to a printer or computer.

**Relative mV measurements**
In this mode, the first mV reading is set to zero and all subsequent readings are relative to this initial mV measurement.
1. Access the mV Measure screen from the main screen.
2. Touch **rel mV** to access the Relative mV screen.
   - When **rel mV** is touched, a dialog box appears.
   - Touch **SET** to set relative mV using numeric keypad and press **Enter** to confirm value.
   - OR
   - Touch **DEFAULT** to accept the default value (0 mV)
3. Immerse the rinsed electrode(s) in the stirring sample.
4. Record the measurement when **STABLE** is displayed.
5. Touch **Print** to store a measurement with an assigned ID# in the data storage center of the meter or print the data to a printer or computer.

Rinse the electrode with water and blot dry. Do not wipe the electrode. Wiping the electrode can cause a static charge on the glass bulb that will result in inaccurate readings.
> Touch rel mV icon for relative mV reading

Sample ID : —
User ID : Default
Temp. : 25.5 C (ATC)
Offset : 0.0 mV

Channel 1

<table>
<thead>
<tr>
<th>abs mV</th>
<th>rel mV</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>STABLE</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>pH</th>
<th>pH (FET)</th>
<th>mV</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Ch1Ch3
Start
5:25 PM
5:25 PM
5:25 PM
The touch screen should be kept as clean as possible to preserve optical properties. Attempt to keep the screen free of dirt, dust fingerprints, etc. Long term contact with abrasive materials will scratch the surface, and impair image quality. To clean, use a damp nonabrasive cloth towel and any commercially available window cleaner. The cleaning solution should be applied to the towel rather than the surface of the touch screen.

The case is made out of durable ABS plastic. It can be cleaned with a damp cloth and a mild detergent. Do not use chemical solvents on the case.
Your XL15 meter contains many error messages to provide aid should trouble occur with a measurement or meter operation (touch pad and input errors). The messages are accompanied by a brief description of the error, and in some cases advice on how to correct it. An example of an error message is:

Bad Electrode Slope-The electrode you have standardized has a slope which is out of the normally acceptable range of 90% to 102%. You should try to restandardize, or replace your electrode if the problem persists. Note that you can continue to make measurements with this electrode; however, the readings may be inaccurate.

Other error messages delivered by the meter are:

- Data Log full
- Data log empty
- Unrecognized date
- Unrecognized time
- Invalid pH limit
- Invalid limit
- Limit exceeded
- Channel 1 exceeded
- Channel 2 exceeded
- Invalid temperature
- Invalid Isopotential
- Invalid Print interval
- Invalid pH value
- Sample ID not found
- Operator ID not found
- Invalid Temperature Coefficient

Also, whenever possible, touch Help for complete information about the meter operation in which you are currently engaged.
pH Meter and Electrode Warranty Statement

The Fisher Scientific Company ("Fisher") warrants to the direct purchaser that the accumet meters and Accumet, AccuTupH, AccuFET, AccupHast, and Microprobe electrodes will be free from defects in material or workmanship for a specified warranty period. During that period, Fisher will repair or replace the product or provide credit, at its sole option, upon prompt notification and compliance with its instructions. For accumet meters, that specified period is 24 months from delivery date. For electrodes, that specified period is 12 months - except for models 13-620-532, 13-620-533, 13-620-534, 13-620-535, 13-620-536, 13-620-537, 13-620-538 and 13-620-539 - which are warranted for six months.

Unless otherwise agreed, the warranty is limited to the country in which the product is sold.

No Fisher employee, agent or representative has the authority to bind Fisher to any oral representation or warranty concerning any product sold. Any oral representation or warranty made prior to purchase of any product and not set forth in writing and signed by a duly authorized officer of Fisher shall not be enforceable by the purchaser.

FISHER EXPRESSLY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTY OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

Fisher's sole responsibility and the purchaser's exclusive remedy for any claim arising out of the purchase of any product listed above is repair, replacement or credit as described above, where applicable. In no event: 1) shall the cost of the exclusive remedy exceed the purchase price; 2) shall Fisher be liable for any special, indirect, incidental, consequential, or exemplary damages, howsoever arising, even if Fisher has been advised of the possibility of such damages.

Each article that Fisher furnishes will conform to the written specifications given in this manual, or those of a further improved model. Changes are made often to the information in the manual and will be incorporated into future editions.
Notice of Compliance

WARNING: This meter generates, uses, and can radiate radio frequency energy. If not installed and used properly, that is in strict accordance with the manufacturer's instructions, it may cause interference to radio communications. It has been tested and found to comply with the limits for a Class A computing device pursuant to Subpart J of Part 15 of FCC Rules, which are designed to provide reasonable protection against such interference when operated in a commercial environment. Operation of this equipment in a residential area may cause interference, in which case the user, at his own expense, will be required to take whatever measures may be required to correct the interference.

This product is to be used only as described in the manual. This product is for indoor use only, and must be used in a well ventilated area.

WARNING: To meet or exceed FCC regulations and comply with CE requirements, the Fisher-supplied power supply must be used. Use of a power supply that is not approved by Fisher Scientific may cause safety hazards and/or cause unit to exceed EMC limits and/or damage unit. When using this meter with a computer or printer, a shielded RS232 cable must be used to meet or exceed FCC regulations, and comply with CE Mark requirements.
The isopotential point of an electrode system is the point at which electrode potential is unaffected by a change in temperature. The coordinates of this point would be reported as \((pX_{iso}, E_{iso})\). For an ideal system, this point would be coincident with the system’s Zero Potential Point \((pX_{0}, E_{0})\).

In practical systems, however, this coincidence rarely occurs, and for some systems, there is no true Isopotential Point but a general Isopotential area. If a system exhibits an apparent Isopotential Point, or at least an Isopotential area with relatively small spread, Isopotential coordinates may be established and possibly used to some advantage. Isopotential correction may be used only in conjunction with a One- or Two-Point Standardization; it is required only when both accuracy over a significant temperature range as well as operation with an asymmetric electrode system are contemplated. However, Isopotential correction is never necessary if all measurements will be performed on samples which are at similar temperatures. Most conventional pH electrode systems are designed and manufactured to be highly symmetrical cells. Consequently, for most pH work, unless ultimate accuracy over broad temperature ranges is required, Isopotential may be ignored. Specifically, this is accomplished by setting the Isopotential at its reset value of zero millivolts.

The following is an example for determining an Isopotential Point:

Data points are first established for three different standards at three different temperatures. The data points are then plotted and will produce three isotherms which should resemble the plot in either figure 1 or figure 2. In figure 1, the Isopotential Point is well defined as the millivolt difference between the coincidence point of the three isotherms \((pX_{iso}, E_{iso})\) and the Zero Potential Point \((E_{0})\). The Isopotential Point is not so well defined in figure 2, but a value may be interpolated with some accepted error.
The following is the list of factory default settings for the AR70 meter. You can reset your meter to the factory default settings by accessing the Reset to Factory Defaults from the System Setup screen.

<table>
<thead>
<tr>
<th>Screen Default Setting</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>pH Setup Mode</strong></td>
<td></td>
</tr>
<tr>
<td>Display configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Print configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Data configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Buffer Group</td>
<td>USA</td>
</tr>
<tr>
<td>Sample ID#</td>
<td>None</td>
</tr>
<tr>
<td>Isopotential Point</td>
<td>0 mV</td>
</tr>
<tr>
<td>Print interval</td>
<td>manual</td>
</tr>
<tr>
<td>Display resolution</td>
<td>XX</td>
</tr>
<tr>
<td>Auto Buffer Recognition</td>
<td>ON</td>
</tr>
<tr>
<td>Auto Read Mode</td>
<td>OFF</td>
</tr>
<tr>
<td>Temperature Units</td>
<td>Celsius</td>
</tr>
<tr>
<td>Default Temperature</td>
<td>25 degree Celsius</td>
</tr>
<tr>
<td>Stability Criteria</td>
<td>Medium</td>
</tr>
<tr>
<td>Default Slope</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>alarm limits</td>
<td>OFF</td>
</tr>
<tr>
<td>alarm limit low</td>
<td>-2 pH</td>
</tr>
<tr>
<td>alarm limit high</td>
<td>20 pH</td>
</tr>
<tr>
<td><strong>mV Setup Mode</strong></td>
<td></td>
</tr>
<tr>
<td>Display configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Print configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Data configuration</td>
<td>All parameters ON</td>
</tr>
<tr>
<td>Sample ID#</td>
<td>None</td>
</tr>
<tr>
<td>Print interval</td>
<td>manual</td>
</tr>
<tr>
<td>Display resolution</td>
<td>XX</td>
</tr>
<tr>
<td>mV Readings</td>
<td>Absolute mV</td>
</tr>
<tr>
<td>alarm limits</td>
<td>OFF</td>
</tr>
<tr>
<td>alarm limit low</td>
<td>-2000 mV</td>
</tr>
<tr>
<td>alarm limit high</td>
<td>+2000 mV</td>
</tr>
</tbody>
</table>
### Replacement Parts

<table>
<thead>
<tr>
<th>Description</th>
<th>Fisher Catalog Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumet pH combination electrode, single junction, Ag/AgCl reference, glass body, BNC connector</td>
<td>13-620-285</td>
</tr>
<tr>
<td>ATC Probe</td>
<td>13-620-19</td>
</tr>
<tr>
<td>AccuFlex electrode support arm</td>
<td>13-637-671</td>
</tr>
<tr>
<td>Electrode support bracket</td>
<td>13-637-671A</td>
</tr>
<tr>
<td>Power Supplies: 115V, US plug</td>
<td>13-636-100</td>
</tr>
<tr>
<td>230V, UK plug</td>
<td>13-636-101</td>
</tr>
<tr>
<td>230V, Europe plug</td>
<td>13-636-102</td>
</tr>
<tr>
<td>Operator’s Manual</td>
<td>13-636-AR50M</td>
</tr>
<tr>
<td>BNC Shorting cap</td>
<td>13-620-99</td>
</tr>
</tbody>
</table>

### Accessories

#### pH Electrode

<table>
<thead>
<tr>
<th>Description</th>
<th>Fisher Catalog Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accumet pH combination electrode, single junction, calomel reference, glass body, BNC connector</td>
<td>13-620-286</td>
</tr>
<tr>
<td>Accumet 3-in-1 pH/ATC combination electrode, single junction, Ag/AgCl reference, glass body, BNC connector</td>
<td>13-620-530</td>
</tr>
<tr>
<td>Accumet 3-in-1 pH/ATC combination electrode, single junction, calomel reference, glass body, BNC connector</td>
<td>13-620-531</td>
</tr>
<tr>
<td>AccupHast pH combination electrode, double junction, glass body, BNC connector</td>
<td>13-620-296</td>
</tr>
<tr>
<td>AccupHast pH combination electrode, double junction, epoxy body, BNC connector</td>
<td>13-620-298</td>
</tr>
<tr>
<td>AccuFET solid state pH/ATC combination electrode, Ag/AgCl gel reference</td>
<td>13-620-755</td>
</tr>
</tbody>
</table>

#### pH Buffers and Solutions

<table>
<thead>
<tr>
<th>pH</th>
<th>Color</th>
<th>Ingredients</th>
<th>Size</th>
<th>Fisher Catalog Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.00</td>
<td>Red</td>
<td>Potassium Biphthalate</td>
<td>500 mL</td>
<td>SB101-500</td>
</tr>
<tr>
<td>7.00</td>
<td>Yellow</td>
<td>Potassium Phosphate Monobasic &amp; Sodium Hydroxide</td>
<td>500 mL</td>
<td>SB107-500</td>
</tr>
<tr>
<td>10.00</td>
<td>Blue</td>
<td>Potassium Carbonate, Potassium Borate &amp; Potassium Hydroxide</td>
<td>500 mL</td>
<td>SB115-500</td>
</tr>
<tr>
<td>Fisher Buffer-Pac</td>
<td>(500mL ea. of color coded pH 4, 7, and 10 buffers)</td>
<td>3x500 mL</td>
<td>SB105</td>
<td></td>
</tr>
<tr>
<td>4.00</td>
<td>Red</td>
<td>Individual Tear open pH Packets</td>
<td>20/box</td>
<td>SB4</td>
</tr>
<tr>
<td>7.00</td>
<td>Yellow</td>
<td>Individual Tear open pH Packets</td>
<td>20/box</td>
<td>SB7</td>
</tr>
<tr>
<td>10.00</td>
<td>Blue</td>
<td>Individual Tear open pH Packets</td>
<td>20/box</td>
<td>SB10</td>
</tr>
<tr>
<td>Gray</td>
<td>Electrode Rinse Individual Tear open pH Packets</td>
<td>20/box</td>
<td>SB15</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Electrode Storage Solution</td>
<td>1L</td>
<td>E40-1</td>
<td></td>
</tr>
</tbody>
</table>

To place an order, call 1-800/766-7000

For a complete selection of electrodes and accessories, please refer to the Fisher 2005/06 Catalog, or contact your Fisher Scientific sales representative.